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Questions Answers 

Can you add comments in Web Viewer? Yes, use the Show button to display the Comments pane and then add comments. 

Can you assign security by folder? Yes, security may be assigned to individual folders in the Report Library. 

Do I need to install each update or can I install CU12 directly 

on CU8? 

You can install CU12 over CU8. 

Do you have to be a user to see Web Viewer? Yes, only valid Management Reporter users can open reports in the Web Viewer. 

How do you schedule reports? Reports are schedule in Report Designer by using the Schedule Reports button on 

the lower-left navigation pane. 

How do you hide comments in the Management Reporter 

viewer? 

Go to View>Fact Pane 

If I have a local install of GP on my laptop, can Management 

Reporter be installed on my laptop to use with the company or 

do I need a Server/Client configuration? 

Management Reporter requires a server/client/network configuration 

Is it possible to remove the "F" in the tab name when 

exporting to Excel? 

No, there is no option currently to do this. 

When will the Management Reporter Legacy connection be 

discontinued? 

The Management Reporter Legacy option is already discontinued for AX with the 

current Management Reporter CU. 

When a user is using Web Viewer, is there a way for the user 

to see all reports that are available?  

No, the only way to view all reports is in the Report Viewer Library. 

When I export a report to Excel, I’m not able to get the 

headers to show up on any page other than the first one.  Is 

there a way to do that? 

No, not currently. 



When we export our files to Excel the header font changes to 

a really large font (i.e. 84pt).  Does this happen often? 

Yes, we do see this with older versions of Microsoft Excel. 

Can the Web Viewer access the archived reports in the 

previous year’s folder in the library? 

Yes, the Web Viewer just needs to point to the URL for those prior reports. 

Does the Management Reporter Viewer have to be a 

Dynamics user to drill back to transaction level? 

No, transaction-level details are a page of the report in the Management Reporter 

Report Viewer or Web Viewer.  

How exactly do you rebuild a DataMart? Please see our message boards at boards.msxgroup.com for more information on 

this topic. 

 

However, the general idea is to delete the current DataMart SQL database and 

use the Management Reporter Configuration console to remove the current 

integration and re-create the DataMart database and integration using the 

Management Reporter Configuration Console. 

What currencies does the currency button display? Does it 

show all the currencies entered in the exchange rate table in 

GL? 

Yes. 

Where are the new 16 default reports or canned reports? If they are not available under a Default Report definitions folder under Reports in 

Report Designer, go to Tools>Import Default Reports. 

Where do you set the default viewer? In Report Designer, go to Tools>Options 

Are all Account Categories shown or only the stock GP 

categories? 

Any account categories defined in the GL should be accessible. 

Can you only get G/L data? Correct. Management Reporter is only capable of pulling in data stored in the GL. 

At present, it is not capable of pulling data from other Dynamics modules. 

Can I install CU12 without having to install all the prior CU's? All CUs are cumulative. Except for pre-Management Reporter2012 versions, you 

should be able to apply any new CU without applying preceding ones. Check the 

download instructions for any exceptions or other requirements. 



When you have opened multiple windows, how do you close 

them? 

File | Close All 

How much is the AX summit and dates? Please see the website for more information on DC Summit: 

http://www.dynamiccommunities.com/summit 

Can you use Management Reporter if you are not a Microsoft 

Dynamics ERP user? 

Microsoft only makes Management Reporter available to Microsoft Dynamics ERP 

customers. 

If you rename a static report and archive it when you rerun 

this report will it overwrite the previous report but with a 

different name? 

No, it will not overwrite the report.  You overwrite a report (create another version 

of report) if the report name and folder are same in Report Definition. 

In order to go back into Dynamics, do you have to have the fat 

client on your PC?  Does it only go into G/L data within 

Dynamics or can you get to A/P data (i.e. invoice images) as 

well? 

If you want to drill back to Dynamics, you need to have it installed on your 

workstation. 

In FRx we could use different row formats for different 

branches of the tree.  Is this possible in Management 

Reporter? 

In FRx there was the ability in the tree to use different rows but in Management 

Reporter that is not available (only one row for entire report).  You could consider 

separate reports in Management Reporter that are grouped together or use 

multiple FD/GL links in the row format. (This is an advanced topic we can help with 

one-on-one offline.) 

Where was the shrink-to-page option to get all the columns on 

same page of report? 

In the Report Definition, go to the Settings tab and the Other button at the bottom. 

When you run a schedule, can it be pushed out to specific 

individuals or does it just go straight to the library? 

It goes to the Library and can also go as links to SharePoint folders. 

Does deleting reports in the Report Library help performance? It probably won't make a big difference normally as the files are small. However, as 

more and more versions are added, it can affect performance. 

How is XBRL functionality used for other countries with actual 

version, which uses XBRL for Germany only?  

 

Kenny, We have your question. We will ask Jill Carter to address it during the Q&A 

session. If we are not able to address it today, all Q&A will be posted on 

MSXGroup.com next week.  



How many of the Report Definitions come with reporter versus 

those that are developed by the Report Designer? 

Management Reported includes several default reports, representing examples of 

various different types. These reports are built to utilize Account Categories, so 

they should work for any company setup. 

Can you pull budgets from multiple companies? Management Reporter can display Budget data that has been uploaded to your 

budget ledger(s) in your GL. In short, budget data can be imported.  

 

In addition, some most Dynamics GLs support using the Forecaster Data Transfer 

Tool, which facilitates importing budget data from Microsoft Forecaster. The FDTT 

can be configured to transfer data for multiple companies/databases. 

With regard to the Export Account Detail to Excel feature: 

When will the Excel outline feature be available? 

Microsoft has not planned on adding Excel outline as an output option yet. 

We have a client that implemented Management Reporter for 

a small division creating about 10 reports. Now, the parent 

company is ready to move. Do we lose the prior reports? 

No you will not lose the reports as long as you keep the SQL database the reports 

are stored in (database name usually "ManagementReporter"). From there, you 

can export/import reports between environments. 

For scheduled reports: Can you be prompted for the report 

date? 

No, scheduled reports run at their scheduled time(s) for the date assigned at the 

report or group definition level. 

Does a Viewer have to be a Dynamics user to drill back to the 

transaction level? 

No, they just have to be a user defined in Management Reporter and be on the 

same network where all reports stored. (This being a secure, SQL database 

Report Library on your network.) 

Will you gentlemen be attending GPUG Summit in Reno-

Tahoe come October? 

Noah, Nick and Derek all intend to be in Reno and we will be leading several 

sessions there.  

Can an end user (Viewer) refresh a preliminary P&L report at 

any time during the period or does a Designer need to run or 

refresh the report again in order for Viewers to see updated 

balances? 

Not all users have the 'refresh' button available. 



What does the Publish button do? Once you are done making adjustments and you've verified the data using refresh 

in the Web Viewer, you may want to publish that report for everyone else to view. 

 

With Management Reporter CU9, this can all be done from the Web Viewer: The 

output locations and report dates used when the report was originally generated 

are used when you press the Publish button. Without having to go back into 

Report Designer, you're able to easily publish out reports to those who need them.   

 

For more information see:  

http://blogs.msdn.com/b/dynamics_financial_reporting/archive/2014/05/15/publish-

a-report-from-the-management-reporter-web-viewer-cu9-feature.aspx 

What is the recommended update for AX 2009 to use 

Management Reporter? Can I use Management Reporter with 

R5? 

Please reference the Microsoft blog site:  

http://blogs.msdn.com/b/dynamics_financial_reporting/archive/2014/03/25/manage

ment-reporter-feature-and-version-number-summary.aspx    

Can you set it up to automatically go to Excel like FRx? Reports can only be exported to external applications from the Web or Report 

Viewers 

Where is the graph in the Web Viewer? Use the SHOW button in lower right, then Graphs 

What currencies does the Currency button display? Does it 

show all the currencies entered in the exchange rate table 

entered in GL? 

The Currency button in the Web Viewer allows you to change the report display to 

different currencies that are posted/converted in the GL. 

Are there differences in the drill to account and transaction 

levels results - when using ranges, versus wildcards - versus 

Account Categories in the row definition? 

The drill down is the same to Account and Transaction level for the scenarios 

inquired about. 

In FRx we find a number of clients use the full account 

number in the column H. Will Management Reporter translate 

this? 

The migration wizard will convert full accounts to Management Reporter. However, 

it will not convert any column H information for reports that do not reference a 

company on the report in FRx. In this instance, change @Any to reference a 

particular company.  

http://blogs.msdn.com/b/dynamics_financial_reporting/archive/2014/05/15/publish-a-report-from-the-management-reporter-web-viewer-cu9-feature.aspx
http://blogs.msdn.com/b/dynamics_financial_reporting/archive/2014/05/15/publish-a-report-from-the-management-reporter-web-viewer-cu9-feature.aspx
http://blogs.msdn.com/b/dynamics_financial_reporting/archive/2014/03/25/management-reporter-feature-and-version-number-summary.aspx
http://blogs.msdn.com/b/dynamics_financial_reporting/archive/2014/03/25/management-reporter-feature-and-version-number-summary.aspx


 

Also, it will not convert any references to Account Sets, which will need to be re-

created in Management Reporter as Dimension Value Sets. 

If you leave the “Chained To” on the Report will it fail the 

migration or will the link to the Chained Report simply not 

migrate? 

The Report will still migrate over and you will use Report Groups in Management 

Reporter to manage this. 

In order for an individual to view a report via a Web Viewer e-

mail link do they need to have Management Reporter installed 

on their machine? 

No, the user doesn’t need Report Designer or Report Viewer installed on their 

machine to view a Management Reporter report in Internet Explorer or other web 

browsers. 

Is it possible to change how a report is exported to Excel?  It 

currently exports to Page Layout view instead of Normal view. 

There are several options in terms of exporting to Excel. However, there have 

been several enhancements to this functionality in recent updates, so you may 

need to apply the latest CU to get all available options. 

How are Attributes these brought in to your drop down 

selection?  I know you said by your GL Database, but what 

exactly does that mean? 

These are populated from your GL. There is nothing in Management Reporter that 

needs to be completed separately. 

My Management Reporter implementation did not 

automatically put a "C" for credit balance on the revenue 

accounts.  Is there a setting or option I need to turn-on? 

This would be a setting in the GL that Management Reporter reads from the 

account setup window. 

The option to insert a quick chart is greyed out for me.  How 

can I enable this option? 

To graph data in the Management Reporter client viewer, right-click in the Report 

Data and you can either select a Row or Column of data to graph, which then 

enables the graph icons on the Toolbar. 

What is best practice when spreading dimensions across a 

column: Dimension Filter or Reporting Unit (Tree)? 

You may want to use Dimension Filter which is easier (as there is no tree 

required).  However, you must use a Tree if the columns are different GL 

companies/database. There you would use the Reporting Tree Filter. 

What do you do for multi-company with 2 segments to get all 

of them? 

Usually you will want to leverage and use the Account detail and have the row be 

summarized using ranges or wild cards.  Or, you could build your row on multiple 

GL segments. This is done using the Build Row on dimensions/segments with the 



“&” when go to Edit | Insert Rows. But, this latter method is not as flexible and 

could be result in a very large row. 

If I’m set to use Web Viewer in the Report Definition - and I 

have links being sent to a shared folder – when I generate a 

group of reports, does a link for the group go to the shared 

folder? 

When report groups are generated, you have the option to use the Distribution 

options defined for each of the reports. Or, you can override and redefine those for 

the group. 

Can you run a summary report that has a tab when exported 

that will give the department account total by account that 

agrees with a summary page? 

When using a reporting Tree, exporting to Excel can include tabs for each 

reporting unit (such as dept.). Also, you have the option to export account and 

transaction details. 

I use Management Reporter but I also have Management 

Reporter Report Viewer as the default viewer (unchecked 

under Tools | Options).  When I open Report Viewer to view 

my reports, I have both programs open. What is the benefit of 

using the Web Viewer?  

While many of the features available in Web Viewer are also available in the 

Report Viewer, there are some features only available in the Web Viewer, such as 

dynamic currency translation and being able to refresh and republish a report 

without using the Report Designer. Also, users are able to access and view reports 

in the Web Viewer without having Report Viewer installed on their workstation. 

Do I need a license to use the Web Viewer While viewing the Web Viewer content does not require an installation of 

Management Reporter Report Viewer, any users accessing Management Reporter 

information must be Management Reporter users. 

How is XPS compared to PDF? XPS is essentially the same as PDF, except that it is a Microsoft tool and is part of 

MS Office. 

We are unable to undo a chart and see it again without 

reopening the report. Are there any plans by Microsoft to fix 

this issue? 

Yes, this is a bug in Management Reporter and we can ask Microsoft later today 

about updates on a fix. 

If you have multi-company in the same database do you have 

to import on the same row definition for each company to get 

all accounts? 

Yes, accounts are company-specific for the option to pull in accounts 

automatically. 

Can you print the detail of this report example like the detail 

(supporting) report in FRx? 

Yes, Management Reporter allows all of the report details to print the same as 

FRx. 



Are the comments available in the Web Viewer? Yes, use the Show button in lower-right, then Comments. 

Can I get a trial balance to not show the rows with zero 

amounts and still show the total row (that equals zero)? 

Yes, use the X0 Print Control code in the Row Definition to hide zero amount rows. 

Can I hide the comment pane? Yes, you can hide or minimize the comments pane in the Report Viewer. 

Is there an easy way to delete multiple reports from the 

library? 

Yes, you can highlight multiple report versions to delete. Report versions can also 

be renamed. 

Can you link a row to an Excel spreadsheet to pull in external 

data? 

Yes, you can. Management Reporter is capable of pulling data from Excel into 

reports in multiple ways. We may touch on the subject in later sessions, but it is 

fairly complex, which precludes a full overview of the functionality here. We cover 

that topic in depth in our Advanced Management Reporter classes. You may also 

be able to get additional information via the Management Reporter online help. 

Can I use the Total row to show information in Management 

Reporter? Or, do I have to use a range of accounts of 

Transaction type? 

Yes, you may use Totaling Accounts that are setup in AX. 

In the Column Definitions, can blank columns be created so 

there is a space between columns of data? 

Yes. You can create blank columns by selecting Fill in the column type field. You 

can then adjust the column width as needed. 

Can you schedule a report group on demand? Yes. You can schedule a report group using the scheduler or you can run the 

report group manually. 

Is there any way to put the Reporting Tree Definitions in one 

report (in a column definition?) instead of generating a 

separate report for each Tree?  

You can assign each column to a specific reporting unit using the Reporting Tree 

filters. All filters must come from the same Tree, which needs to be associated with 

the Report itself. You can achieve similar results using Dimension Filters in the 

column definition instead of Reporting Tree filters. 

Is there a checklist of these available? You can find the list and tips at MSXGroup.com on our Message Board.  

 

We will also be posting the decks for all of today's presentations to 

MSXGroup.com. 



In Management Reporter, if the report is setup to allow drill 

down to the transaction level, what the user sees appears to 

be the description entered for the journal entry.  Is there a way 

for the user to see the vendor name?  I believe in FRx we 

could input a column referencing this and you'd see it when 

you drilled down to that level of detail on the report. 

You can include a vendor name column in the column definition. This option needs 

to be activated in the GL first to make it available for Management Reporter. 

 


